
 U S E R ’ S  M A N U A L
CableModem
Zoom
10BaseT (Ethernet)



NOTICE
This document contains proprietary information protected by copyright, and
this User’s Manual and all the accompanying hardware, software, and
documentation are copyrighted. All rights are reserved. No part of this
document may be photocopied or reproduced by mechanical, electronic, or
other means in any form.

The manufacturer does not warrant that the hardware will work properly in
all environments and applications, and makes no warranty and
representation, either implied or expressed, with respect to the quality,
performance, merchantability, or fitness for a particular purpose of the
software or documentation. The manufacturer reserves the right to make
changes to the hardware and User’s Manual content without obligation to
notify any person or organization of the revision or change.

All brand and product names are the trademarks of their respective owners.
© Copyright 2001.  All rights reserved.



Contents

GETTING STARTED ............................................................... 1

CABLE MODEM SERVICE ........................................................... 1
SYSTEM REQUIREMENTS........................................................... 2
WHAT YOU WILL NEED FOR INSTALLATION................................... 2

INSTALLING YOUR CABLE MODEM........................................... 5

REQUESTING CABLE MODEM SERVICE .......................................... 5
CONFIGURING YOUR COMPUTER’S NETWORK SETTINGS ................... 8
MAKING THE CONNECTIONS .....................................................21

CONFIGURING YOUR BROWSER............................................ 25

INTERNET EXPLORER 4.0.........................................................25
INTERNET EXPLORER 5.X.........................................................26
NETSCAPE NAVIGATOR............................................................27
AOL...................................................................................27

USING YOUR CABLE MODEM ................................................ 29

CONNECTING TO THE INTERNET ................................................29
ENDING AN INTERNET SESSION.................................................29
UNPLUGGING THE MODEM .......................................................29

FRONT PANEL INFORMATION ............................................... 31

TROUBLESHOOTING ............................................................ 32

REGULATORY INFORMATION ................................................ 35

REFERENCE INFORMATION................................................... 36





Getting Started 1

Getting Started

Your Zoom® 10BaseT (Ethernet) Cable Modem is designed to
connect your personal computer to the Internet through the
same cable that you use for television reception.

A cable modem provides several advantages over traditional dial-
up analog modems:

• Transmission speeds are much faster. Because of the increased
speed of a cable modem, you can enjoy faster, more
productive Internet sessions.

• A cable modem frees up your phone line, so you don’t miss
phone calls or have to obtain a dedicated telephone line for
Internet access.

• The cable connection can be “always-on,” so Internet access is
fast and easy.

Cable Modem Service
Your local television cable company provides cable modem service,
also known as cable data service or broadband Internet. The cable
that supplies television service to your home or office is connected
to the modem in the same way that it is connected to your
television set or cable box. You can then get the benefit of high-
speed access to the Internet through the local cable company’s
service. The cable connection to the Internet does not interfere
with your regular cable television signals because the modem
service is provided on different channels than television
programming.
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System Requirements

• Windows® 95/98/Me, Windows NT®, Windows 2000, or
Mac® OS 7.53 or later.

• A 10BaseT (Ethernet) port on your computer. If you do not
have one, you will need to install a Network Interface Card
(NIC). Some cable companies will provide the card and install
it for you.

What You Will Need For Installation
In addition to this manual, check to see that your package includes
the following. If you are missing any item, contact your vendor.

• Zoom Cable Modem

• 6-foot 10BaseT (Ethernet) cable

• Power adapter

Some models may also include a mounting stand.
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In addition to the items packaged with your modem, you will need
the following items to complete your installation.
• Cable modem service provided by your cable company. The

service must be DOCSIS (Data Over Cable Service Interface
Specification) compatible.

• A power outlet.
• A cable TV outlet.
• The proper length of 75-ohm coaxial cable to reach between

your cable modem and the cable outlet

Note: Because there is great variety in the way cable is installed,
Zoom does not provide a coaxial cable to connect to your
cable system. If your cable service company does not
provide one, you should purchase a coaxial cable with an
RG-59 or RG-61U rating (75 ohm) and industry-standard
F connectors. For best performance, do not use “push-
on” F connectors; use only “screw-on” F connectors.
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1
Installing Your Cable Modem

Note: If your cable company provides you with an installation
procedure, follow it instead of the procedure described in
this chapter.

This chapter illustrates a typical cable installation in your home
or office and describes how to connect the Zoom Cable
Modem to your computer.

Installation consists of a few simple steps:

1. Requesting cable modem service from your cable
company.

2. Configuring your computer’s network settings.

3. Making the connections.

Requesting Cable Modem Service
Before you install the Zoom Cable Modem, contact your cable
company to arrange for cable modem service and to establish a
cable modem account.

A cable company representative may take care of the entire
installation for you, or you may get an installation CD from the
company and complete the procedure yourself. If you are doing it
yourself, you will need to provide the following information to the
cable company before you make the connections:
1. The Cable Modem MAC (Media Access Control) Address,

printed on the label on the underside of the modem case.
2. The Ethernet Adapter MAC Address.

To locate this address:
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Windows 95/98/Me operating systems

1 From the Windows desktop, click Start | Run.

2 In the Run dialog box, type winipcfg and click OK.

3 In the IP Configuration dialog box, select your
NIC/Ethernet adapter and write down its 12-
character Adapter Address in the Reference
Information section at the back of this manual.
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Windows NT/2000 operating systems

1 Windows NT:
From the Windows desktop, click Start | Programs
| Command Prompt.

Windows 2000:
From the Windows desktop, click Start | Programs
| Accessories | Command Prompt.

2 In the Command Prompt window, type
ipconfig [space] /all
and press Enter.

3 In the next Command Prompt window, under Ethernet
Adapter, locate the Physical Address and make a note of it.
It’s a good idea to enter it in the Reference Information
section at the back of this manual.

4 Click the Close box    to return to Windows.
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Macintosh operating systems 

1 Choose Apple System Profiler from the Apple menu.

2 In the Apple System Profiler window, click the
Network Overview arrow and then the AppleTalk
arrow.

Locate the 12-character Hardware Address and make a
note of it.

We advise that you record the hardware address in the Reference
Information section at the end of this manual.

Configuring Your Computer’s Network
Settings

Select your operating system:

• Windows 95/98/Me: page 9.

• Windows NT 4.0: page 13.

• Windows 2000: page 15.

• Macintosh: page 19.
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Windows 95/98/Me Network Settings
To configure network settings on a computer running Windows
95/98/Me, follow these steps.

Note: The dialog boxes shown are representative of a typical
computer. What you see on your computer may differ
slightly.

1 From the Windows desktop, click Start | Settings | Control
Panel, and then double-click the Network icon. The
Network dialog box appears.

Click the Configuration tab. A list of installed network
components is displayed. If you see a line that includes
TCP/IP (Transmission Control Protocol/Internet Protocol),
skip to Step 5. If you don’t see that line, continue with Step 2.

2 In the Network dialog box, if TCP/IP is not listed, click the
Add button.
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3 In the Select Network Component Type dialog box, click to
highlight Protocol and then click Add.

4 If prompted at this point, or later in the procedure, insert your
Windows operating system CD and follow the on-screen
instructions.

5 In the Select Network Protocol dialog box, under
Manufacturers, click to highlight Microsoft. Under Network
Protocols, click to highlight TCP/IP. Then click OK.
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6 In the Network dialog box there should now be an entry for
TCP/IP. (Click No if you are asked to restart your
computer.) Highlight TCP/IP and click Properties.
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7 The TCP/IP Properties dialog box is displayed. In the IP
Address tab, click Obtain an IP address automatically.

8 Click the WINS Configuration tab. Click Use DHCP for
WINS Resolution and click OK.
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9 The Network dialog box from Step 1 is displayed again.
Make sure TCP/IP is highlighted, and click OK to enable
your settings.

10 If prompted, restart the computer.

You have configured your Windows 95/98/Me network settings
successfully. Now turn to Making the Connections on page 21.

Windows NT 4.0 Network Settings 

Note: The information shown in your dialog boxes may differ
from the examples.

1 On the desktop, click Start | Settings | Control Panel, and
then double-click the Network icon.

2 In the Network dialog box, click the Protocols tab to view
the Network Protocols list.

If you see a line that includes TCP/IP Protocol
(Transmission Control Protocol/Internet Protocol), skip to
Step 5. Otherwise, continue with Step 3.
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3 In the Network dialog box, if TCP/IP Protocol is not listed,
click Add.

4 If prompted at this point, or later in the procedure, insert your
Windows operating system CD and follow the on-screen
instructions.

5 In the Select Network Protocol dialog box, highlight
TCP/IP Protocol, and then click OK.

6 In the Network dialog box (see Step 2), under Network
Protocols, highlight TCP/IP Protocol, and then click
Properties.
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7 In the Microsoft TCP/IP Properties dialog box, select your
Network Interface Card from the Adapter list, and click
Obtain an IP address from a DHCP server.

Click OK to enable your settings.

8 The Network dialog box reappears. Click OK.

You have configured your Windows NT network settings
successfully. Now turn to Making the Connections on page 21.

Windows 2000 Network Settings 
To configure network settings on a computer running Windows
2000, follow these steps.

Note: The dialog boxes shown below are typical. Individual
computer dialog boxes may vary.
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1 From your computer’s desktop, click Start | Settings
| Network and Dial-Up Connections.

2 The Network and Dial-Up Connections window is
displayed. Right-click the Local Area Connection icon, and
click Properties.

3 The Local Area Connection Properties dialog box appears.
You see a list of installed network components. If you see a
line that includes TCP/IP (Transmission Control
Protocol/Internet Protocol), skip to Step 7. If you don’t see
the line, click the Install button and continue with Step 4.



Installing Your Cable Modem 17

4 In the Select Network Component Type dialog box,
highlight Protocol and click Add.

5 If prompted at this point, or later in the procedure, insert your
Windows operating system CD and follow the on-screen
instructions.

6 In the Select Network Protocol dialog box, click to highlight
Internet Protocol (TCP/IP) and click OK.

7 The Local Area Connection Properties dialog box from
Step 3 is displayed. Click to select Internet Protocol
(TCP/IP), and then click Properties.
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8 In the Internet Protocol (TCP/IP) Properties dialog
box, select Obtain an IP address automatically, and
Obtain DNS server address automatically. Click OK
to enable your settings.

9 The Local Area Connection Properties dialog box from
Step 3 is displayed again. Click OK.

10 In the Network and Dial-Up Connections window,
click  to close.

11 If prompted, restart the computer.

You have configured your Windows 2000 network settings
successfully. Now turn to Making the Connections on page 21.
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Macintosh Network Settings 
To configure the network settings on your Macintosh, follow these
steps:

1 Choose Control Panels from the Apple menu and then
TCP/IP (Transmission Control Protocol/Internet
Protocol) to display the TCP/IP dialog box (you will use
this dialog box in Step 6).

2 On the main toolbar, choose Configurations from the File
menu.

3 In the Configurations dialog box, click Duplicate.

4 In the Duplicate Configuration dialog box, type “Zoom
Cable Modem” and click OK.
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5 In the Configurations dialog box, highlight Zoom Cable
Modem and click Make Active.

6 In the TCP/IP dialog box, in the Connect via pop-up
menu, select Ethernet. In the Configure pop-up menu,
select Using DHCP Server.

7 Close the TCP/IP dialog box. You will be asked if you want
to save the changes. Click Save.

You have configured your Macintosh network settings successfully.
Now turn to Making the Connections on page 21.
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Making the Connections
Typical connections are illustrated below.
The first diagram shows an installation with modem and cable TV.
The modem should be placed on a port of the first splitter inside
your home or office, and should be kept on a separate circuit from
your cable television service. 

It is possible that the signal going from the cable modem back to
the cable provider’s central office may interfere with signals from
the TV set-top box for Pay Per View or Video on Demand
services. If this happens, a high-pass filter should be installed at the
input of the 2:1 splitter going to the TV sets, as shown above.
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The illustration below shows a typical direct connection to a cable
outlet.

Coaxial
cable

10BaseT
(Ethernet)
cable

Power
adapter

CAUTION • Locate the modem so that there is one inch of
free space between its top and sides and any
other device or the wall. This free space will
ensure proper air circulation. Do not block
the vents in any way. Failure to allow proper
air circulation can result in serious damage to
the cable modem.

• Do not place any items on top of the modem
while it is powered up.

• Do not place the modem near a heating or air
conditioning duct, in direct sunlight, or in a
location susceptible to drastic temperature
changes.
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All connections are made on the rear panel of the modem as
shown below.

Note: You must give the Cable Modem MAC and Ethernet
Adapter addresses to your cable company before you
connect the modem. See page 5.

Cable and Power Connections

1 Turn your computer on.

2 Connect one end of the 10BaseT/Ethernet cable to the 10BT
jack on the rear of the modem and the other end to the
10BaseT jack on your computer.

3 Connect the coaxial cable to the cable jack on your wall. (If
you are using a splitter, follow the directions on page 21.)
Connect the other end of the cable to the cable connector on
the back of the modem.

4 Insert the small round end of the power cord into the power
socket on the back of the modem. Plug the power adapter into
the wall socket. The READY and 10BT lights on the front
panel come on.

The cable modem now starts the synchronization process
described below.

Automated Synchronization

The lights on the front panel (see above) indicate the status of the
synchronization process.
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After the modem completes a self-test, it synchronizes with the
cable provider network. During this process, the SYNC light
blinks, rapidly at first, then slowly. The ACT light flickers briefly as
the modem receives information from the cable provider.

Note: Synchronization can take from 20 seconds to five minutes.

When the process is complete, the SYNC light becomes steady
On.

For details on the front panel lights and their modes, see
Appendix A on page 31.

This completes the installation of the modem. Please turn to the
next section, Configuring Your Browser, on page 25.

Tip: If you want to use your cable modem with more than one
computer, please contact your cable service provider.
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2
Configuring Your Browser

An Internet browser is a program used to find and display Web
pages. To find a page, the browser must connect to the
Internet, via either phone lines or a LAN (Local Area Network). 

When using a cable modem, you need to set the browser to
connect to the Internet via a LAN.

This chapter describes how to configure some of the most
common Internet browsers. It is beyond the scope of this
manual to give step-by-step instructions for all versions of all
browsers, so the instructions below cover only the major
versions of the most common browsers. If you are using
another browser, please consult the documentation that came
with it.

Internet Explorer 4.0

1 Start Internet Explorer.

2 Open the View menu and select Internet Options.

3 In the Internet Properties dialog box, click the Connections
tab.

4 Click Connect to the Internet using local area network, and
click OK.
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Internet Explorer 5.x

1 On your desktop, click the Internet Explorer icon.
If you cannot access the Internet Explorer menu, follow these
steps:

a Click Start | Settings | Control Panel.

b Click the Internet Options icon, and go to Step 3.

2 Click the Tools menu, and then Internet Options.

3 In the Internet Properties dialog box, click the Connections
tab.

4 On the Connections tab, click the LAN Settings button.
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5 In the Local Area Network (LAN) Settings dialog box,
select Automatically detect settings and click OK.

Netscape Navigator

1 On the desktop, click the Netscape Navigator icon.

2 From the Edit menu, select Preferences.

3 In the Preferences dialog box, click the Advanced option,
and then click Proxies.

4 Select the option that allows you to connect to the Internet
directly.

AOL

AOL 5.0 or higher has a cable modem option that configures your
connection automatically.

Now that you’ve configured your browser, turn to Chapter 3,
Using Your Cable Modem, on page 29.
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3
Using Your Cable Modem

Once you’ve installed the modem and configured your browser
to use a LAN, connecting to the Internet is as simple as clicking
the icon that corresponds to the desired Internet application. 

Note: At this time you may also want to install and use other
software, such as the programs furnished by your cable
service provider. Refer to the CD(s) for installation
instructions.

Connecting to the Internet
When you have correctly installed the Zoom Cable Modem, it
powers up and synchronizes itself with the cable network. The
READY light, 10BT light, and SYNC light go on, indicating that
the modem is fully operational.

To connect to the Internet, start your browser or other Internet
application.

Ending an Internet Session
After you have completed your Internet session, just close your
browser. The Zoom Cable Modem remains connected with the
cable system and stays ready to open another session.

Unplugging the Modem
If the Zoom Cable Modem is unplugged or if power is lost for any
other reason, all communication between the modem and the cable
system is terminated. When the power is restored, the cable
modem must go through the full synchronization process before
you can connect to the Internet. This process is performed
automatically when the modem is powered up.
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Note: If your cable TV service is interrupted, your cable modem
service will also be interrupted. If you are unable to
connect to the Internet, or if your browser notes that it is
unable to find a selected URL, check to make sure that
your cable TV service is operational. If not, contact your
cable service provider.
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Appendix A
Front Panel Information

After you’ve correctly installed the Zoom Cable Modem, the
READYREADYREADYREADY light, 10BT10BT10BT10BT light, and SYNCSYNCSYNCSYNC light go on to indicate that
the modem is fully operational.

Light Mode Status

READYREADYREADYREADY On Power is on.

10BT10BT10BT10BT On The 10BaseT/Ethernet Cable
Modem is connected to the
computer (the computer must be
turned on).

ACTACTACTACT Blinking Activity is present on the cable.
The cable modem is sending
data to the cable service provider
or receiving data from it.
This light flickers during the
synchronization process.

SYNCSYNCSYNCSYNC Blinking Fast Searching for a data channel
from the cable provider.

Blinking Slow Synchronizing with the cable
network and adjusting the signal
for optimum performance.

Steady On The modem is synchronized to
the cable network.
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Appendix B
Troubleshooting

This section provides tips for troubleshooting your cable
modem in the event of minor problems. In addition, check the
Cable Modem Frequently Asked Questions (FAQs) section on
our website:  http://www.zoom.com/cable/faqs.html

Note: If your cable modem is not responding, the first step
should be to reinstall it. This may take a few minutes, but
it is frequently the quickest and easiest solution.

Problem: I cannot access my Internet service or send or
receive email.

Solutions:

• Check all physical connections. The READY, 10BT,
and SYNC lights on the modem’s front panel must all
be a steady green before your cable modem will work.

• Check to see that your cable TV service is working. If
not, call your cable service provider.

• Verify that the MAC and Ethernet Adapter addresses
you gave to your service provider are correct, and that
they are entered into their system. See page 5.

• Make sure your Network Interface Card is functioning
correctly. Refer to the documentation if necessary.

• Check that TCP/IP is configured correctly. Refer to
the section of this manual entitled Configuring Your
Computer’s Network Settings on page 8. Verify
that the TCP/IP parameters supplied by your cable
company are correct and up-to-date.

Problem: The power to my cable modem goes on and off.

http://www.zoom.com/


Appendix B: Troubleshooting 33

Solution: Check that you are using the adapter that came with
your cable modem.

Problem: I receive the message “Unknown Network
Adapter.”

Solution: This problem can occur if a Network Interface Card is
physically present and was recognized by Plug-and-
Play, but was not installed correctly. Reinstall it.

Problem: I receive the message “Undetected Network
Adapter.”

Solution: The Network Interface Card is missing or incorrectly
installed. Reinstall it.

Problem: I receive the message “Missing Internet
Protocol.”

Solution: Refer to Configuring Your Computer’s Network
Settings on page 8.

Problem: I receive the message “Cannot Find Files; Insert
Operating System Disk.”

Solution: Your computer is looking for the files included on the
original operating system CD or diskettes that came
with your computer. Remove your modem CD or
diskette (if any) and insert your operating system CD
or disk. Be sure to remove the operating system CD
when you’re done and reinsert your modem CD or
diskette if applicable.
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Problem: The Cable Modem’s SYNC light blinks for 5
minutes, goes off, comes on again and repeats.

Solution:

• Make sure the connection is secure.

• Check with your cable service provider to make sure
that high speed access is available and running.

• In rare instances, the cable signal may be low. Be sure
the modem is attached to one of the ports on the first
splitter after the cable enters your home or office (see
page 21).

• Make sure there is no video amplifier on the same line
with the cable modem. (A video amplifier prevents
data from returning to the cable provider’s central
office.)

Tip: When your cable modem service is restored after a
disruption, if you are having difficulty communicating,
disconnect and then reconnect the power, and let the
modem go through the synchronization process again.
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Appendix C
Regulatory Information

FCC Part 15 Emissions Statement 
This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency and, if
not installed and used in accordance with the instructions, may cause harmful
interference to radio communications.
However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off and
on, the user is encouraged to try to correct the interference by one or more of the
following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to

which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

Industry Canada Emissions Statement 
This Class B digital apparatus meets all requirements of the Canadian Interference-
Causing Equipment Regulations.
Cet appareil numérique de la classe B respecte toutes les exigences du Règlement
sur le matériel brouilleur du Canada.

Electrostatic Discharge Statement 
This unit may require resetting after a severe electrostatic discharge event.

Declaration of Conformity
The manufacturer declares under sole responsibility that this equipment is
compliant to Directive 1999/5/EC (R&TTE Directive) via the following:

Directives Standards
73/23/EEC EN 60950
89/336/EEC EN 55024
89/336/EEC EN 55022
The product is CE marked.
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Reference Information

We recommend that you take a few moments to fill in the
following information for your future reference.

In the event you need to call Customer Support, you will need the
information below.

Cable Modem ModelCable Modem ModelCable Modem ModelCable Modem Model ________________________________________________________________________________
(printed on the box and the label on the bottom of the modem)

Serial NumberSerial NumberSerial NumberSerial Number ________________________________________________________________________________
(S/N, printed on the label on the bottom of the modem)

Cable Modem MAC ACable Modem MAC ACable Modem MAC ACable Modem MAC Adddddressdressdressdress________________________________________________________________________________
Media Access Control address (printed on the label
on the bottom of the modem)

Ethernet Adapter/Hardware Address Ethernet Adapter/Hardware Address Ethernet Adapter/Hardware Address Ethernet Adapter/Hardware Address ________________________________________________________
Address of the Network Interface Card (see page 5)

Date of PurchaseDate of PurchaseDate of PurchaseDate of Purchase ________________________________________________________________________________

Dealer or VendorDealer or VendorDealer or VendorDealer or Vendor ________________________________________________________________________________
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